Chapter 1. Overview



Introduction



GnuCash is the personal finance software package made for you. It is versatile enough to keep track of
      all your financial information, from the simple to the very complex. It is one of the few
      financial software packages that supports global currencies, and it is the only open-source
      program of its kind. Best of all, GnuCash is easy to learn and use!
    
So, what can GnuCash do for you? It can keep track of your personal finances in as much detail as you
      prefer. If you are just starting out, use GnuCash to keep track of your checkbook. You may then
      decide to track cash as well as credit card purchases to better determine where your money is
      being spent. When you start investing, you can use GnuCash to help monitor your portfolio.
      Buying a vehicle or a home? GnuCash will help you plan the investment and track loan payments.
      If your financial records span the globe, GnuCash provides all the multiple-currency support you
      need.
    
Figure 1.1. A Chart Of Accounts With Multiple Currencies And Investments
[image: A Chart Of Accounts With Multiple Currencies And Investments]This image shows a Chart of Accounts with multiple currencies and investments.
            





While GnuCash is well suited for personal finances, it is also powerful enough for business use. There
      are many business features, from integrated accounts receivable and payable systems, to tax
      table construction. You will find these and the many other business features surprisingly
      powerful and easy to use.
    


Getting More Help



GnuCash offers help in many ways, including the  Tip of the
      Day, context help, a website, a wiki, the mailing lists, and IRC chat.
    
Context Help



The context help provides detailed instructions for using GnuCash's menus, windows, and controls. To
        open online help, select Help → Contents.
      
The GnuCash Help window also acts as a simple web browser, so you can pull up
        a website for additional information. You can open any website under this window by clicking
        the Open Toolbar button and then typing in the
        URL. Use the Back, Forward,
        Reload, Stop, and Print
        buttons as you would in a standard browser.
      

GnuCash Website



The GnuCash website
        contains helpful information about the program and about any updates to it. It also contains
        links to other online resources.
      

GnuCash Wiki



An immense amount of less-formal documentation, both of GnuCash itself and its maintenance and
        development may be found in the GnuCash Wiki.
      

GnuCash Frequently Asked Questions




            GnuCash Frequently Asked Questions (FAQ) page 
            is also on the GnuCash Wiki.
            It should be a first stop whenever you encounter difficulty using GnuCash.
            It is now translated into German and Simplified Chinese. If you'd like to access to the translated page,
            see tabs on the top of the GnuCash Frequently Asked Questions page.

        

GnuCash On-line Assistance




        Mailing List
      
The primary source of user support is the user
        mailing list. If you prefer a web forum-like presentation, you can use it via
        Nabble.
        One must
        subscribe
        before posting, even if using Nabble.
      

        IRC
      
Several of the developers monitor the #gnucash channel at irc.gimp.net.
        They are usually busy with other tasks and of course are not always at their computers.
        Log in, ask your question, and stay logged in; it may take  several hours before your question is noticed and responded.
        
	If you got disconnected check the IRC logs to verify that you
              missed nothing related.
            
	Requirements, netiquette, and other details are explained in the IRC
              wiki page.
            



      
The GnuCash website  has more details on these channels.
        You will also find pointers there to additional useful resources such as the GnuCash wiki and
        bug tracking system.
      

Topic Search



The online manual also provides a search function. To search for a particular topic, click the
        Search tab at the bottom of the help window and type in your topic in
        the field provided. Click the Search button to complete your search.
        A list of choices should appear in the box below, clicking a choice will bring up its text
        on the right.
      


Part I. The Basic Knowledge




Data Entry Concepts



When entering data in GnuCash, you should be aware of the 3 levels of organization in which GnuCash
      divides your data: files, accounts and transactions. These levels are presented in their order
      of complexity, one file contains many accounts and one account contains many transactions.
      This division is fundamental to understanding how to use GnuCash.
    
Files



GnuCash stores information at the highest level in files. A file can be stored on your computer either
        as a single XML file (in all versions of GnuCash), or in a
        SQL database (in GnuCash version 2.4 and higher).
      
Note
SQL is pronounced “sequel”, so in spoken and written language we
          would say “a SQL database”.
        

With the XML file format, GnuCash stores your data in an XML
        data file, usually in compressed format (although this can be changed in the
        General tab of the GnuCash Preferences).
      
With SQL storage, GnuCash stores your data in a SQL database
        under the database application you select (SQLite3, MySQL or PostgreSQL).
      
You will need one main file or database for each set of accounts you are maintaining. To learn how
        to create and manage GnuCash files, see the section called “Storing your financial data”.
      
Note
If you think you might need more than one set of accounts, you might want to consult a professional
          accountant or bookkeeper before proceeding. Most users will probably have only one data
          file.
        

Backup files and log files are automatically generated by GnuCash when appropriate. Backup and log
        files are described in the section called “Backing Up and Recovering Data”.
      

Accounts



An account keeps track of what you own, owe, spend
        or receive. Each GnuCash file can contain any number of accounts, and each account can contain
        many sub-accounts up to an arbitrary number of levels. This simple feature gives GnuCash much
        of its power in managing your finances, as you will see in later chapters.
      
Examples of accounts include: checking accounts, savings accounts, credit card accounts, mortgages,
        and loans. Each GnuCash account tracks the activity for that “real” account, and
        can inform you of its status.
      
In addition, accounts are also used to categorize the money you receive or spend. For example, you
        can create expense accounts to track the money you pay on utilities or groceries. Even
        though these are not accounts that receive statements, they allow you to determine how much
        money is being spent in each of these areas.
      
Accounts will be covered in more detail in the section called “Accounts”.
      

Transactions



A transaction represents the movement of money among accounts. Whenever you
        spend or receive money, or transfer money between accounts, that is a transaction.
      
Examples of transactions are: paying a phone bill, transferring money from savings to checking,
        buying a pizza, withdrawing money, and depositing a paycheck. the section called “Transactions”
        goes more in depth on how to enter transactions.
      
In double entry accounting, transactions always
        involve at least two accounts–a source account and a destination account. GnuCash
        manages this by inserting a line into the transaction for every account that is affected,
        and recording the amounts involved in each line. A line within a transaction that records
        the account and amount of money involved is called a split. A
        transaction can contain an arbitrary number of splits.
      
Note
Splits in transactions will be covered in the section called “Split Transaction Example”
        



Accounts



This section discusses some useful concepts for organizing your accounts. Since GnuCash does not
    impose any specific account tree layout, you are free to design your account structure in any
    manner you wish. However, there are a few basic accounting concepts which you will probably want
    to follow when designing your accounts to maximize their utility.
  
Basic Accounting Concepts



As we saw in the previous chapter, accounting is based on 5 basic account types:
      Assets, Liabilities, Equity,
      Income and Expenses. We will now expand on our
      understanding of these account types, and show how they are represented in GnuCash. But first,
      let’s divide them into 2 groups, the balance sheet accounts and the income and expense
      accounts. As the name says the balance sheet accounts can be summarized in the balance of what
      you own and owe at a point in the time, while the income and expense
      accounts can be summarized in the Profit & Loss report, which shows the change
      of values in a period of time like the economic year.
    
Let’s have a quick look at the Accounting Equation (Assets - Liabilities = Equity +
      (Income - Expenses)) again as a reminder, before we go deeper into each account
      type.
    
Figure 2.14. The basic accounts relationships
[image: The basic accounts relationships]A graphical view of the relationship between the 5 basic accounts. Net worth (equity) increases
              through income and decreases through expenses. The arrows represent the movement of
              value.
            





Balance Sheet Accounts



The three so-called Balance Sheet Accounts are Assets,
        Liabilities, and Equity. Balance Sheet Accounts
        are used to track the things you own or owe.
      
Assets is the group of things that you own. Your assets could include a car,
        cash, a house, stocks, or anything else that has convertible value. Convertible value means
        that theoretically you could sell the item for cash.
      
Liabilities is the group of things on which you owe money. Your liabilities
        could include a car loan, a student loan, a mortgage, your investment margin account, or
        anything else which you must pay back at some time.
      
Equity is the same as "net worth." It represents what is left over after you
        subtract your liabilities from your assets. It can be thought of as the portion of your
        assets that you own outright, without any debt.
      

Income and Expense Accounts



The two Income and Expense Accounts are used to increase or decrease the value
        of your accounts. Thus, while the balance sheet accounts simply track
        the value of the things you own or owe, income and expense accounts allow you to
        change the value of these accounts.
      
Income is the payment you receive for your time, services you provide, or the
        use of your money. When you receive a paycheck, for example, that check is a payment for
        labor you provided to an employer. Other examples of income include commissions, tips,
        dividend income from stocks, and interest income from bank accounts. Income will always
        increase the value of your Assets and thus your Equity.
      
Expense refers to money you spend to purchase goods or services provided by
        someone else for early consumption. Examples of expenses are a meal at
        a restaurant, rent, groceries, gas for your car, or tickets to see a play. Expenses will
        always decrease your Equity. If you pay for the expense immediately, you will decrease your
        Assets, whereas if you pay for the expense on credit you increase your Liabilities.
      


GnuCash Accounts



This section will show how the GnuCash definition of an account fits into the view of the 5 basic
      accounting types.
    
But first, let’s begin with a definition of an account in GnuCash. A GnuCash
      account is an entity which contains other sub-accounts, or that contains
      transactions. Since an account can contain other accounts, you often see
      account trees in GnuCash, in which logically associated accounts are
      grouped together within a common parent account.
    
A GnuCash account must have a unique name (that you assign) and one of the predefined GnuCash
      “account types”. There are a total of 12 account types in GnuCash. These 12 account
      types are based on the 5 basic accounting types; the reason there are more GnuCash account types
      than basic accounting types is that this allows GnuCash to perform specialized tracking and
      handling of certain accounts. There are 6 asset accounts (Cash,
      Bank, Stock, Mutual Fund,
      Accounts Receivable, and Other Assets), 3 liability
      accounts (Credit Card, Accounts Payable, and
      Liability), 1 equity account (Equity), 1 income
      account (Income), and 1 expense account (Expenses).
    
These GnuCash account types are presented in more detail below.
    
Balance Sheet Accounts



The first balance sheet account we will examine is Assets, which, as you
        remember from the previous section, refers to things you own.
      
To help you organize your asset accounts and to simplify transaction entry, GnuCash supports several
        types of asset accounts:
      
	Cash Use this account to track the money you have on hand, in your wallet, in
            your piggy bank, under your mattress, or wherever you choose to keep it handy. This is
            the most liquid, or easily traded, type of asset.
          

	Bank This account is used to track your cash balance that you keep in
            institutions such as banks, credit unions, savings and loan, or brokerage firms -
            wherever someone else safeguards your money. This is the second most
            liquid type of account, because you can easily convert it to cash
            on hand.
          

	Stock Track your individual stocks and bonds using this type of account. The
            stock account’s register provides extra columns for entering number of shares and
            price of your investment. With these types of assets, you may not be able to easily
            convert them to cash unless you can find a buyer, and you are not guaranteed to get the
            same amount of cash you paid for them.
          

	Mutual Fund This is similar to the stock account, except that it is used to
            track funds. Its account register provides the same extra columns for entering share and
            price information. Funds represent ownership shares of a variety of investments, and
            like stocks they do not offer any guaranteed cash value.
          
GnuCash treats account types Stock and Mutual Fund the same.
          

	Accounts Receivable (A/Receivable) This is typically a business use only
            account in which you place outstanding debts owed to you. It is considered an asset
            because you should be able to count on these funds arriving.
          
Transactions involving an Accounts Receivable account should not be added, changed or deleted in any
            way other than by using
          
	post/unpost bill/invoice/voucher or
              

	process payment
              




	Asset No matter how diverse they are, GnuCash handles many other situations
            easily. The account type “Asset”, covers all assets not listed above.
          
GnuCash treats account types Cash, Bank and Asset the same.
          
Accounts are repositories of information used to track or record the kinds of actions that occur
            related to the purpose for which the account is established.
          
For businesses, activities being tracked and reported are frequently subdivided more finely than
            what has been considered thus far. For a more developed treatment of the possibilities,
            please read the descriptions presented in Chapter 15, Other Assets of this
            Guide.
          
For personal finances a person can follow the business groupings or not, as they seem useful to the
            activities the person is tracking and to the kind of reporting that person needs to have
            to manage their financial assets. For additional information, consult
            Chapter 15, Other Assets of this Guide.
          



The second balance sheet account is Liabilities, which as you recall, refers to
        what you owe, money you have borrowed and are obligated to pay back some day. These
        represent the rights of your lenders to obtain repayment from you. Tracking the liability
        balances lets you know how much debt you have at a given point in time.
      
GnuCash offers three liability account types:
      
	Credit Card Use this to track your credit card receipts and reconcile your
            credit card statements. Credit cards represent a short-term loan that you are obligated
            to repay to the credit card company. This type of account can also be used for other
            short-term loans such as a line of credit from your bank.
          

	Accounts Payable (A/Payable) This is typically a business use only account in
            which you place bills you have yet to pay.
          
Transactions involving an Accounts Payable account should not be added, changed or deleted in any
            way other than by using
	post/unpost bill/invoice/voucher or
                

	process payment
                




          

	Liability Use this type of account for all other loans, generally larger
            long-term loans such as a mortgage or vehicle loan. This account can help you keep track
            of how much you owe and how much you have already repaid.
          
GnuCash treats account types Credit Card and Liability the same.
          



Tip
Liabilities in accounting act in an opposite manner from assets: credits
          (right-column value entries) increase liability account balances and
          debits (left-column value entries) decrease them. (See note later in
          this chapter)
        

The final balance sheet account is Equity, which is synonymous with “net
        worth”. It represents what is left over after you subtract your liabilities from your
        assets, so it is the portion of your assets that you own outright, without any debt. In
        GnuCash, use this type of account as the source of your opening bank balances, because these
        balances represent your beginning net worth.
      
There is usually only a single GnuCash equity account, called naturally enough,
        Equity. For companies, cooperatives etc. you can create a subaccount
        for each partner.
      
Tip
In equity accounts, credits increase account balances and debits decrease them. (See note later in
          this chapter)
        

Note
The accounting equation that links balance-sheet accounts is Assets = Liabilities + Equity or
          rearranged Assets - Liabilities = Equity. So, in common terms, the things you
          own minus the things you owe equals your net
          worth.
        


Income and Expense Accounts



Income is the payment you receive for your time, services you provide, or the
        use of your money. In GnuCash, use an Income type account to track these.
      
Tip
Credits increase income account balances and debits decrease them. As described in
          the section called “Accounting Concepts”, credits represent money transferred
          from an account. So in these special income accounts, when you
          transfer money from (credit) the income account to another account,
          the balance of the income account increases. For example, when you
          deposit a paycheck and record the transaction as a transfer from an income account to a
          bank account, the balances of both accounts increase.
        

Expenses refer to money you spend to purchase goods or services provided by
        someone else. In GnuCash, use an Expense type account to track your
        expenses.
      
Tip
Debits increase expense account balances and credits decrease them. (See note later in this
          chapter.)
        

Note
When you subtract total expenses from total income for a time period, you get net income. This net
          income is then added to the balance sheet as retained earnings, which is a type of
          Equity account.
        

Below are the standard Income and Expense accounts after
        selecting Common Accounts in the assistant for creating a new Account
        Hierarchy (Actions → New Account Hierarchy...).
      
Figure 2.15. Default Income Accounts
[image: Default Income Accounts]This image shows the standard Income accounts.
              





Figure 2.16. Default Expense Accounts
[image: Default Expense Accounts]This image shows some standard Expense accounts.
              






Other Account Types



There are some special other account types.
      
Trading Multiple currency transactions have splits in “Trading”
        accounts to make the transaction balance in each currency as well as in total value. See
        Chapter 12, Multiple Currencies for more information.
      
Money Market and Credit Line are used only in the OFX
        importer, apparently for completeness with the specification.
      


Putting It All Together



Let’s go through the process of building a common personal finance chart of
      accounts using the information we have learned from this chapter. A chart of
      accounts is simply a new GnuCash file in which you group your accounts to track your finances.
      In building this chart of accounts, the first task is to divide the items you want to track
      into the basic account types of accounting. This is fairly simple, let’s go through an
      example.
    
Simple Example



Let us assume you have a checking and a savings account at a bank, and are employed and thus receive
        a paycheck. You have a credit card (Visa), and you pay monthly utilities in the form of
        rent, phone, and electricity. Naturally, you also need to buy groceries. For now, we will
        not worry about how much money you have in the bank, how much you owe on the credit card,
        etc. We want to simply build the framework for this chart of accounts.
      
Your assets would be the bank savings and checking account. Your
        liabilities are the credit card. Your Equity would
        be the starting values of your bank accounts and credit card (we do not have those amounts
        yet, but we know they exist). You have income in the form of a salary,
        and expenses in the form of groceries, rent, electricity, phone, and
        taxes (Federal, Social Security, Medicare) on your salary.
      

The Basic Top Level Accounts



Now, you must decide how you want to group these accounts. Most likely, you want your
        Assets grouped together, your Liabilities grouped
        together, your Equity grouped together, your
        Income grouped together, and your Expenses grouped
        together. This is the most common way of building a GnuCash chart of accounts, and it is
        highly recommended that you always begin this way.
      
Start with a clean GnuCash file by selecting File → New File from the menu. The New Account Hierarchy Setup assistant will start.
        Press Cancel to close the assistant as we don’t want to use one of
        the predefined accounts structure; instead we will build a basic starting account structure
        from scratch. In the empty GnuCash window select View → New Accounts Page from the menu: the Accounts tab will open. Finally select Actions → New Account....
      
Now you are ready to build this basic starting account structure
      
	Account name Assets (account type Asset, parent account
            New top level account)
          
Figure 2.17. Creating an Assets account
[image: Creating an Assets account]This image shows the dialog to create an asset account.
                  






	Account name Liabilities (account type Liability, parent
            account New top level account)
          

	Account name Equity (account type Equity, parent account
            New top level account)
          

	Account name Income (account type Income, parent account
            New top level account)
          

	Account name Expenses (account type Expenses, parent
            account New top level account)
          



When you have created the top-level accounts, the main Account page in GnuCash should look like below.
      
Figure 2.18. The Basic Top-level Accounts
[image: The Basic Top-level Accounts]This image shows the basic top-level accounts.
              






Making Sub-Accounts



You can now add to this basic top-level tree structure by inserting some real transaction-holding
        sub-accounts. Notice that the tax accounts are placed within a sub-account named
        Taxes. You can make sub-accounts within sub-accounts. This is typically
        done with a group of related accounts (such as tax accounts in this example).
      
Tip
Instead of selecting Actions → New Account... from the menu, you can alternatively create a new sub-account of an account by right clicking on the
          main account’s name and selecting the New Account... entry.
          This will open a dialog similar to the one depicted in
          the section called “The Basic Top Level Accounts” where the new sub-account will be already set
          as a child of the main account.
        

	Account name Cash (account type Cash, parent account
            Assets)
          

	Account name Checking (account type Bank, parent account
            Assets)
          

	Account name Savings (account type Bank, parent account
            Assets)
          

	Account name Visa (account type Credit Card, parent
            account Liabilities)
          

	Account name Salary (account type Income, parent account
            Income)
          

	Account name Phone (account type Expense, parent account
            Expenses)
          

	Account name Electricity (account type Expense, parent
            account Expenses)
          

	Account name Rent (account type Expense, parent account
            Expenses)
          

	Account name Groceries (account type Expense, parent
            account Expenses)
          

	Account name Taxes (account type Expense, parent account
            Expenses)
          

	Account name Federal (account type Expense, parent account
            Expenses:Taxes)
          

	Account name Social Security (account type Expense, parent
            account Expenses:Taxes)
          

	Account name Medicare (account type Expense, parent
            account Expenses:Taxes)
          

	Account name Opening Balance (account type Equity, parent
            account Equity)
          



After you have created these additional sub-accounts, the end result should look like below
      
Figure 2.19. The Basic Chart of Accounts
[image: The Basic Chart of Accounts]This image shows a simple chart of accounts.
              





Save this chart of accounts with the name gcashdata_3, as well as
        gcashdata_3emptyAccts, as we will continue to use them in the later
        chapters.
      
You have now created a chart of accounts to track a simple household budget. With this basic
        framework in place, we can now begin to populate the accounts with transactions. The next
        chapter will cover this subject in greater detail.
      



Chapter 3. Importing Data into GnuCash



This chapter will detail procedures for importing data into GnuCash.
  
Importing Transactions from Files



Outdated
This is an older version of
      “Common Transaction
      Operations” in the manual. Better continue there until this update anomaly is
      resolved.
    

Imported transactions will generally be to a specific account in your account tree. In the following
      this will be referred to as the import or
      base account. It may or may not be specified in the data
      being imported, depending on the import format. It is usually the first split of a transaction
      being imported.
    
All transactions will also must have a destination account for at
      least matching splits. This may or may not be supplied in the imported data. If it is not, an
      account can be assigned on the basis of the previous import history by matching to infomation
      in the imported data. The user may always over-ride this assignment.
    
Multi-split data previously exported from GnuCash may have both the import and destination accounts
      for transaction splits specified in the data file.
    
File Import Formats



Gnucash allows transactions to be imported in the following formats:
      
	QIF (.qif) Quicken Interchange
            format - import data from Quicken financial software;
          

	OFX/QFX (.ofx,.qfx) Open
            Financial eXchange format (QXF is an Intuit/Quicken proprietary version of OFX);
          

	CSV (.csv) Comma Separated
            Values;
          

	MT940 MT940
          

	MT942 MT942
          

	DTAUS DTAUS
          



These import methods can be accessed from
        File → Import ...
        .
      

Import Matcher



Several of the Import Assistants use an Import Matcher to implement a Bayesian approach to assign
        destination accounts, if such accounts are not specified in the imported data, to each
        imported transaction based on the previous import history of the import account. It also
        attempts to match the transactions being imported to any existing transactions based on the
        date and the description fields

        .
      
Transaction rows which match existing transactions already in the import account are flagged not to
        be imported. They will have a light green background and the A and U+R checkboxes will be
        unchecked and the R checkbox will be checked. To override and import the transaction, check
        the A checkbox. The U and R boxes will be unchecked automatically. The reliability of the
        match is indicated by a bar display in the Info column. If a destination account for the
        second split is assigned by the matcher if will be appended to the info column.
      
Transaction rows which do not match existing transactions in the import account, for which an
        assignment of a destination account cannot be made on the basis of the previous import
        history to the account, will be displayed with an orange-yellow background and the A box
        will be checked and U+R and R unchecked. A destination account must be specified for these
        transactions.
      
Assign a Destination Account to a Single Transaction



The currently selected row is selected by Left-clicking it. It is displayed with a mid dark green
          background.
        
Double click on a row. This will select it and open an Account
          Selection dialog. Select the desired destination account in the dialog and click
          OK. The row background will change to a light green and the assigned
          destination account will be displayed in the Info column.
        
or alternatively, Left-click on a row to select it followed by a
          Right-click to bring up a popup menu then select "Assign
          a transfer account" to display the Account Selection dialog, select the destination
          account and click the OK button.
        

Assign a Destination Account to Multiple Transactions



Sometimes you will have several transactions which will have the same destination account. Gnucash
          allows you to select multiple transactions and apply the same destination account to all
          transactions in the selection.
        
Rows in a selection are displayed with a mid dark green background.
        
Multiple rows may be selected to have the same destination account assigned to them.
        
To select rows either:
        
	Left click on first row and then Ctrl-Left
              click on other rows to add to the selection or
            

	Left-click on a first row and then
              Shift-Left-click on another row to select all rows
              between them.
            



then Right-click to display a popup menu and then select
          "Assign a transfer account" to open the Account Selection
          dialog. Select the desired destination account and click the OK
          button in the Account Selection dialog.
        

Completing the Import



Once you have assigned destination accounts for all the imported transactions using the above
          methods (all row backgrounds will be a light green colour), check that the assigned
          destination acounts are correct and then press the OK button at the
          bottom of the Generic Import Matcher window. The transactions selected for import will
          have their splits added to the selected source and destination accounts.
        
The choices made for the destination accounts and description/memo fields are remembered and stored
          and used for future imports to the same account to automatically assign a destination
          account for transaction records not containing destination account information.
        


Import QIF



To import data from Quicken®, MS Money, or other programs that use QIF(Quicken® Interchange
        Format), you must first export your data to a QIF file. One way to do this is to export each
        account as a separate QIF file. An easier way, available in Quicken® 98 and beyond, is to
        export all accounts at once into a single QIF file. Check your program's manual to determine
        if this option is available.
      
To import QIF files:





Load all of the QIF files containing data you wish to import



To do this, select File -> Import -> Import QIF... from the menu.
          When the QIF Import dialog box appears, click Next and
          follow the instructions to guide you through the process of loading your files.
        
This image shows the start of the QIF Import assistant.

        
You will be prompted for a filename to load. Use the Select button to select your QIF file and click
          Next to load it. Once the file is loaded, select Load another file if you have more files
          to load. When you have loaded all your QIF files, click Next to continue with the import
          process.
        

Review the GnuCash accounts to be created.



The importer then matches up your QIF accounts and categories with GnuCash accounts and gives you a
          brief description of the matching process. Clicking Next will bring you to a view
          comparing your QIF accounts with the corresponding GnuCash accounts created. To change an
          account name, select the row containing that account name and edit the name in the dialog
          box provided. Click Next when you have finished making changes, and proceed through a
          similar category matching process. QIF income and expense categories import as GnuCash
          income and expense accounts

          Make changes to these account names if necessary, and click Next to continue.
        
Note: If you are not sure what changes are needed, it is safe to
          accept the GnuCash account names. It is easy to edit the accounts later if you find you
          need to make a change.
        
From the drop-down list, select a standard currency to be used for the imported accounts and click
          Next to continue. If you have stocks, mutual funds, or
          other securities, you will be prompted for additional information. The importer dialog
          will ask for the exchange or listing (i.e. Nasdaq), the security's full name, and the
          ticker symbol. If you do not have this information handy, you can edit the account
          information later, once the import is complete. Click
          Next to continue.
        

Tell GnuCash to import the data.



The last step is the import. Once you have verified your account names and investment information,
          click Finish in the Update your GnuCash accounts page to
          complete the import process. Depending upon the size of your file, the import might take a
          few minutes to complete, so a progress bar displays the percentage finished. When the
          import process is complete, GnuCash will return you to the main window, which should now
          display the names of the accounts you imported.
        


Import OFX/QFX



This opens a file selection dialog. Navigate to the file you wish to import, select a file with the
        appropriate extension (.ofx or .qfx), then press the Import
        button.
      
Gnucash opens an Account Selection dialog to select an account in your CoA corresponding to data
        source. Select the appropriate account from the account tree and press the
        OK button. On subsequent import of files from the same
        source (identified by tags in the file), the source is remembered and the account selection
        dialog is not displayed.
      
The generic import transaction matcher dialog is opened next. See the
         Import Matcher section (common to both OFX/QFX and
        CSV import formats) following the Import CSV section to continue the import process.
      

Import CSV



Clicking on Import CSV in the Import menu will bring up the Import
        Assistant dialog. The first step brings up a file selection dialog. Navigate to the location
        where the file you wish to import is located and select the file to import then click the
        OK button.
      
The next window will allow you to set parameters for the importing of the file. All widgets have
        tooltips which explain what the setting affects and the options for the setting.
      
Load and Save Settings



If this import is a regular occurrence, once you have set the other import paramters, you can save
          these settings by typing in a setting name in the Load and Save
          Settings Entry combo box and pressing the Save
          button just to the right of the box. Previously defined settings can be retrieved by
          selecting the appropriate setting name from the dropdown list activated by the down arrow
          at the right end of the text box. The trash can button to the right of the Save button can
          be used to remove the settings selected from the drop down list for the box. The settings
          group "GnuCash Export Settings" define a setting group
          for the export and reimport of GnuCash transaction data - use this if importing data
          previously exported from GnuCash.
        

Account



This combo box allows you to select the base or import account into which the transactions will be
          imported. It may be left unset if the imported data contains a column listing the accounts
          associated with each split or the import data specifies the account for first split of the
          transaction.
        

File Format



This section allows you to define whether the file has:
        
	Fixed width columns Selecting this radio button will allow you to
              define column boundaries by double clicking at the appropriate positions in the sample
              records displayed in the panel below. Single clicking in a column will narrow, widen
              or merge the column.
            

	Separators Selecting this radio button will allow you to define
              characters which will be used to distinguish columns in the input file. The default is
              comma separated however spaces, tabs,colons or semicolons or any combination of them
              may be used to separate columns in the input file by selecting the appropriate check
              boxes. You may also define custom separators by typing the required characters into
              the text box and selecting the Custom checkbox. This
              may be used in combination with any of the predefined separators.
            

	Multi-split Selecting this check box allows the splits for a single
              transaction to be defined on consecutive lines within the file with each line defining
              a single split. If not selected each line is assumed to contain the information for a
              single transaction including one or two splits.
            




Miscellaneous



The miscellaneous settings allow you to set:
        
	EncodingThis is usually the UTF-8 variant for your locale;
            

	Date Format This does not default to the Locale setting so check it
              matches the data you are importing;
            

	Currency Format;
            

	Leading Lines to Skip Can be set to skip a number of non-transaction lines preceding the actual data. This can include a field name header or an introduction section in the import file;
            

	Trailing Lines to Skip Can be set to skip a number of non-transaction lines following the actual data. This can include a summary section;
            

	Skip alternate lines When set only every other line will be imported, starting from the first line not skipped with the "Leading Lines to Skip" option;
            



to match the settings for the file you are importing. Tooltips may also contain information on the
          setting and options.
        

Import Panel



The import panel shows the data being imported as it is interpreted using the settings chosen to
          define columns and formats. The dropdown lists in the headers for each column of the
          import allow you to associate a specific column in the imported data with a specific field
          in the display of a transaction in an account register. At a minimum to import data,
          columns in the imported data containing the following information
          must be specified:
        
	Date of transaction;
            

	Account into which transaction is to be imported (or alternatively
              set the base account as above);
            

	Description of the transaction;
            

	Deposit or Withdrawal column.
            



The Skip Errors check box will skip trying to import any rows with
          errors in matching the columns.
        
When you are happy with all the import settings, save them
          if you will use the same settings again, then press the
          Next button. This will bring up a window which allows you
          to map the accounts identified in the account column (Account Id) with accounts in the
          GnuCash account tree (Account name). Double click on a row to bring up a dialog to select
          the matching GnuCash account. When you have selected a match for all accounts, click on
          the Next button.
        
The Transaction Information panel allows review of data entry settings so far.
        
Clicking on Match Transactions will then bring up the main Import
          Matcher window described in the next section.
        


Import MT940



Use this option to import MT940 data.
      

Import MT942



Use this option to import MT942 data.
      

Import DTAUS



Use this option to import DTAUS data.
      



Chapter 4. Configuring GnuCash



This chapter will detail preference settings for GnuCash.
  
Overview



Configuring is fun.
    


Chapter 5. Checkbook



This chapter will give you all the specific information you need to manage your checkbook with
    GnuCash. Managing your checkbook register is the first step of tracking your finances, and GnuCash
    makes it much easier to manage than the traditional paper register does.
  
For one thing, as discussed in the section called “Transactions”, data entry of common
    transactions is practically done for you in GnuCash, because of its auto-completion feature. GnuCash
    keeps a running balance of each account, and it makes reconciling these accounts easy. And the
    double-entry method helps you account for your spending by requiring a transfer account for
    withdrawals, so you can easily find out how much money you spend in different areas.
  
Once you are comfortable with using GnuCash for your checking and other bank accounts, you may wish to
    continue on with tracking other financial accounts. Chapters 6 through 9 examine methods to
    manage your other accounts.
  
Setting up Accounts



The first step in managing your checkbook is to set up the necessary accounts. You can either use
      the default GnuCash accounts or set up your own. For more detail on how to set up a new account,
      refer to the section called “The Basic Top Level Accounts”. For instructions on importing your
      accounts from another program, refer to the GnuCash manual.
    
Let’s start with the bank accounts you’ll need. You need one GnuCash bank type account for
      each physical bank account you wish to track. If you are setting up your own accounts or using
      the default GnuCash accounts, make sure that you have an opening balance transaction for each
      bank account you own. The easiest way to get this number is to use the balance from your last
      bank statement as your opening balance. You can enter this in the account information window
      automatically as part of the New Account Hierarchy Setup assistant, or
      you can enter a manual transaction directly in the account. To enter the transaction manually,
      enter a transfer from an Opening Balances account (type equity) to the
      bank account.
    
The typical bank accounts you might track include:
    
	Checking - any institutional account that provides check-writing privileges.
        

	Savings - an interest-bearing institutional account usually used to hold money for a longer term
          than checking accounts.
        



Common transactions that affect these bank accounts are payments and deposits.
      Payments are transfers of money out of the bank account, usually to an
      expense account. Deposits are transfers of money into the bank account,
      usually from an income account. You will need to set up income and expense accounts to track
      where that money comes from and where it goes. Remember that a balanced transaction requires a
      transfer of an equal sum of money from at least one account to at least one other account. So
      if you deposit money in your checking account, you must also enter the account that money
      comes from. If you pay a bill from your checking account, you must also enter the account
      where that money goes.
    


Entering Withdrawals



When you withdraw money from your bank account, for whatever reason, you are transferring money from
      your bank account to some other location. In GnuCash, this other location is tracked as an
      account. The more detailed accounts you create and use for your spending, the more information
      you will get about where your money goes.
    
Withdrawals take many forms. ATM withdrawals are one of the most common transactions. Writing checks
      is one way to withdraw money to pay bills, to buy purchases, or to give to charity. Depending
      on your bank, you might also have service charges, where the bank withdraws the money from
      your account. Transfers of money out to another account are also withdrawals. We will take a
      look at each of these types of withdrawals and how to record them in GnuCash.
    
ATM/Cash Withdrawals



Cash withdrawals are handled as a transfer from a bank account to a cash account. GnuCash provides
        special Cash type accounts for tracking your cash purchases, so you
        should set up a cash account to record your ATM and other cash withdrawals.
      
Cash accounts can be used for different levels of detail. On a basic level of detail, you simply
        transfer money to it from your checking account. That tells you how much money you took out
        of checking on a given day, but it doesn’t tell you where that cash was spent. With a
        little more effort, you can use the cash account to record your cash purchases as well, so
        that you can see where that cash went. You record these purchases as a transfer from the
        cash account to expense accounts.
      
Some people record every cash purchase, but this takes a lot of work. An easier way is to record the
        purchases for which you have receipts, but then adjust the balance of the account to match
        what is in your wallet.
      
It’s a good idea to at least set up a cash account for your withdrawals. Then if you decide to
        track where your cash goes, you can enter transactions for the money you spend. You
        determine what level of detail you want to use.
      


Reconciling Your Accounts



GnuCash makes reconciliation of your bank account with your monthly bank statement much easier.
      the section called “Reconciliation” gives instructions on how to reconcile your
      transactions with the monthly bank statement. This is the main reconciliation task that should
      be done every month.
    
But what about all those other accounts you created? Should those be reconciled too? If you receive
      a statement for the account, then you should consider reconciling that account. Examples
      include the checking account statement, the savings account statement, and the credit card
      statement. Credit card statements and credit card transactions are covered in the
      Chapter 7, Credit Cards, so if you are interested in tracking your credit cards in
      GnuCash, take a look at the instructions provided there.
    
Income and expense accounts are usually not reconciled, because there is no statement to check them
      against. You also don’t need to reconcile cash accounts, for the same reason. With a
      cash account, though, you might want to adjust the balance every once in a while, so that your
      actual cash on hand matches the balance in your cash account. Adjusting balances is covered in
      the next section.
    

Chapter 6. Expense Accounts



If managing your checkbook is the first step in tracking your finances, then using expense accounts
    to see where you are expending money is a close second step. This chapter will give you an
    understanding of how GnuCash uses expense accounts to help you keep track of many different
    categories of transactions.
  
Concepts



An expense type account is used to allow you to track how much you spend on specific expenses. Many
      people's first experience with tracking expenses comes from Quicken(tm), where transactions
      can be assigned to one or more categories. In GnuCash, these categories are set up as separate
      accounts, which are designated as Expense type accounts. This allows GnuCash to apply the rules
      of double-entry accounting consistently. Expense accounts can be as detailed or as general as
      you need. Some users need only a few accounts for personal expense tracking. Others use GnuCash
      expense accounts to manage their expenses in great detail. The level of detail you choose is
      up to you. Keep in mind that with GnuCash, you can change accounts for transactions, so if your
      needs change later on, it is possible to move transactions around.
    


Entering Charges



Entering your charges provides you with a more complete picture of your spending habits. Charges on
      a credit card are tracked as a transaction between the credit card liability account and the
      appropriate expense account.
    
When you pay for goods or services with your credit card, you are telling the credit card company to
      pay the merchant for you. This transaction will increase the amount of money you owe the
      credit card company, and the credit card balance will increase. The other side of these
      transactions will in most cases be an expense account. For example, if you buy clothing from a
      store with your credit card for $50, you would be transferring that money from the credit
      account into Expenses:Clothing.
    
Entering these transactions into GnuCash allows you to track how much you owe the credit card company,
      as well as provides you a better picture of your overall accounts. It also allows you to
      monitor your account and ensure that fraud is avoided.
    
Adding transactions to a credit card account is similar to entering transactions in other accounts.
      You can enter them manually, or import them from your credit card company using a compatible
      import format.
    
For assistance with entering transactions, see Chapter 6 of the GnuCash Manual and
      the section called “Transactions”.
    

Chapter 8. Loans



This chapter explains how to manage your loans with GnuCash.
  
Basic Concepts



A loan is defined as a financial transaction in which someone pays for the use of someone
      else’s money. There are many familiar examples of loans: credits cards, auto loans,
      house mortgages, or a business loan.
    
Terminology



Before discussing tracking loan in GnuCash specifically, it will be helpful to present a glossary of
        terminology. The terms presented below represent some of the basic concepts found concerning
        loans. It is a good idea to become familiar with these terms, or at least, refer back to
        this list if you encounter an unfamiliar word in the later sections.
      
	Amortization
	The repayment plan which will insure that a loan is eventually paid off, typically utilizing equal
              valued monthly payments. These payments are usually split into principal and interest,
              where the amount of principal per payment increases (and interest decreases) as the
              amortization period elapses.
            

	Borrower
	The person or company that receives the money from a loan.
            

	Default
	The time when a borrower fails to repay a loan according to the terms agreed upon with the lender.
            

	Deferment
	A temporary delay in the repayment of a loan.
            

	Delinquency
	It is the term that refers to late payments.
            

	Disbursement
	An amount of the loan paid to the borrower. Some loans have multiple disbursements, meaning the
              borrower does not receive the full amount of the loan at one time.
            

	Interest
	The expense charged by the lender to the borrower for the use of the money loaned. This is typically
              expressed in terms of a yearly percentage charged on the principal borrowed, known as
              the Annual Percentage Rate or APR.
            

	Lender
	The company or person who lends money to a borrower.
            

	Loan Fee
	A processing fee removed from the principal at the time the borrower receives a loan.
            

	Principal
	The original amount of the loan, or the amount of the original loan that is still owed. When you
              make a monthly payment on a loan, part of the money pays the interest, and part pays
              the principal.
            

	Promissory Note
	The legal agreement between the borrower and lender concerning the loan.
            






Reconciling with the Loan Statements (How-To)



Reconciling a loan statement is not different from reconciling a bank or credit card statement.
    
During the period you should have recorded all the various loan related transactions, and every one
      of them are touching the Liability:Loans:Loan
      account. For instance, paying off a bit of the loan decreases your Bank
      Account and Loan account, and increases the Loan
      Interest as well as perhaps Loan administration fee.
    
With the loan statement in your hands, open the Loan account, start the reconcile assistant, and
      tick of all the various transaction you have recorded. When you have finished, the reconciling
      difference should be 0, and if it is not, then you will have to go through the account and
      compare it with the loan statement to find the difference. When you have reached a 0 in
      difference, then your loan account is reconciled and you can finish the Reconcile assistant.
    
For more information on how to Reconcile, please check the section called “Reconciliation”.
    

Chapter 11. Capital Gains



This chapter will present some of the techniques used to keep track of the unrealized and realized
    gains and losses, better known as capital gains and losses.
  
Basic Concepts



This chapter will present some of the techniques used to keep track of the unrealized and realized
      gains and losses, better known as capital gains and losses.
    
Certain resellable assets can change value over time, such as stocks, bonds, houses, or cars. Some
      assets could increase in value, some could decrease in value. It is
      important to be able to track some of these time-dependent asset valuations, this chapter will
      show you how.
    
Probably everything you own will increase or decrease in value over time. So, the question is for
      which of these assets should you track this changing value? The simple answer is that you only
      need to track this for items which could be sold for cash in the future or which relate to
      taxation.
    
Consumable and disposable items (for example, food, gas for your car, or printer paper) are obviously not
      involved. Thus, even though the new clothes you recently bought will certainly depreciate, you
      would not want to track this depreciation since you have no intention of reselling the clothes
      and there is no tax implications to the depreciation on clothing. So, for this example, the
      purchase of new clothes should be recorded as a pure expense... you spent the money, and it is
      gone.
    
Asset appreciation occurs when something you own increases in value over time. When you own an asset
      which has increased in value, the difference between the original purchase price and the new
      value is known as unrealized gains. When you sell the asset, the profit
      you earn is known as realized gains or capital
      gains. An example of an asset from which you could have unrealized gains, and
      eventually capital gains, is stock in a publicly traded company.
    


Account Setup



Important

        In the next few sections, unrealized gain accounts are created, and the estimated unrealized gain transactions 
        are recorded there in order for users to understand unrealized gain easily. However, it is not necessary
        to record unrealized gains unless large corporations like which adopt IFRS in actual accounting.
        The small enterprise users, who are using GnuCash, should not record unrealized gains. Record into GnuCash 
        only when realized gains are fixed.
      

As with most accounting practices, there are a number of different ways to setup capital gains
      accounts. We will present here a general method which should be flexible enough to handle most
      situations. The first account you will need is an asset Cost account
      (GnuCash account type Asset), which is simply a place where you record the
      original purchase of the asset. Usually this purchase is accomplished by a transaction from
      your bank account.
    
In order to keep track of the appreciation of the asset, you will need three accounts. The first is
      an Unrealized Gains asset account in which to collect the sum of all of
      the appreciation amounts. The Unrealized Gains asset account is balanced
      by a Unrealized Gains income account, in which all periodic appreciation
      income is recorded. Finally, another income account is necessary, called a Realized
      Gains in which you record the actual capital gains upon selling the asset.
    
Below is a generic account hierarchy for tracking the appreciation of 2 assets,
      ITEM1 and ITEM2. The Assets:Fixed
      Assets:ITEM1:Cost accounts are balanced by the Assets:Current
      Assets:Savings account, the Assets:Fixed Assets:ITEM1:Unrealized
      Gains accounts are balanced by the Income:Unrealized Gains
      account (similar for ITEM2).
    

-Assets
    -Current Assets
        -Savings
    -Fixed Assets
        -ITEM1
            -Cost
            -Unrealized Gains
        -ITEM2
            -Cost
            -Unrealized Gains
-Income
    -Realized Gains
    -Unrealized Gains

Chapter 12. Multiple Currencies



This chapter will show how to set up GnuCash accounts to use multiple currencies.
  
Basic Concepts



GnuCash supports over a hundred currencies, from the Andorran Franc to the Zimbabwe Dollar. For
      example, you can have a bank account set up in Euros, and another using Hong Kong Dollars.
    
Some of the issues which arise when using multiple currencies are as follows:
    
	How do you transfer funds between accounts with different currencies?
	How do you calculate the overall value when you have mixed currency accounts?
	How do reports deal with mixed currencies?



    
You can either deal with multiple currencies using manually entered transactions to record currency
      gains and losses as described in the section called “Manually Recording Currency Transaction” or you can utilize
      currency trading accounts introduced with GnuCash version 2.3.14 to automatically record the
      gains and losses on transactions between currencies as described in the subsequent section.
      Trading accounts are not enabled by default in GnuCash and must be explicitly enabled as
      described in the section called “Automatically Recording Currency Transactions using Trading Accounts”.
    


Chapter 13. Business Features



Introduction to Business Features



The accounting needs of a business are quite different from that of a person. Businesses have
      customers that owe money, vendors which are owed money, employee payroll, more complex tax
      laws, etc. GnuCash offers business oriented features to facilitate these needs.
    
Accounts Receivable (A/R) are used by businesses to record sales for which they
      are not immediately paid. This is represented on the balance sheet as an asset, because the
      expectation is that you will receive payment soon.
    
Accounts Payable (A/P) record bills that businesses have received, but may not
      pay until later. This is represented on the balance sheet as a liability because you will have
      to pay for them.
    
A/R and A/P accounts are used primarily when you have a lot of bills and receipts flowing in and
      out, and do not want to lose track of them just because you do not pay or get paid right away.
      For most home users, A/R and A/P are too complicated to be worthwhile.
    


Accounts Receivable



Accounts Receivable (or A/R) refers to products or services provided by your company for which
      payment has not yet been received.
    
System Components



Transactions generated by the A/R system are recorded within the Accounts Receivable account.
        You should not work directly with this account. Instead, you will work
        with the four integrated GnuCash A/R application components available through the
        Business → Customer
        sub-menu. These four components are:
      
	Customers are people or companies to whom you sell products or services on
            credit.
          

	Invoices represent the physical invoice you send to a customer to request
            payment. This invoice contains an itemized list of things you sold.
          
In addition, GnuCash also has support for Credit Notes which represent the
            inverse of Invoices. A credit note is usually handed to a customer to correct items that
            were incorrectly invoiced or returned.
          
Both document types will be set up using the same menu items. Credit notes were introduced starting
            with GnuCash stable release 2.6.0.
          

	Jobs (optional) is where you register Customer Jobs. Jobs are a mechanism by
            which you can group multiple invoices to a particular customer.
          

	Process Payments is used to register payments you received from a customer.
          




Customers



Customers are people or companies to whom you sell goods or services. They must be registered within
        the A/R system.
      
New



To register a new customer, enter the menu
          Business → Customer → New
            Customer
          . Fill in customer information, such as Company Name, Address, Phone, Fax, etc.
        
Figure 13.6. New Customer Registration Window
[image: New Customer Registration Window]




Find and Edit



To search for an existing customer, use the
          Business → Customer → Find
            Customer
          window. You select a customer to View/Edit from the results of the
          search. This window is also used to look up customers when creating invoices and
          processing payments.
        
Figure 13.7. Find Customer Window
[image: Find Customer Window]



If many customers match the search criteria you provide, the search can be refined by running an
          additional search within the current results. The current result set is searched when the
          Refine Current Search radio button is selected. In fact, GnuCash
          selects this option for you after you run the initial search.
        
If the customer you are searching for does not match the supplied search criteria, change the search
          criteria, click the New Search radio button and then the
          Find button. The relevant step is the New Search
          selection. If the customer is not in the result of the original search, and you only
          search within this set, the customer cannot be found, regardless of new search criteria.
        
Note
To return a list of all registered active customers, set the search criterion to matches
            regex, and place a single dot "." in the text field area. Make sure
            Search only active data is checked, then click
            Find. The regular expression "." means to match anything.
          



Invoices



An invoice is the paperwork you send to a customer to request payment for products or services
        rendered. GnuCash can generate and track invoices.
      
A credit note is the paperwork you send to a customer to correct products or services rendered that
        were incorrectly invoiced. GnuCash can generate and track credit notes via the same menu
        entries as invoices.
      
Note
This section applies to both invoices and credit notes. In order to avoid repeating everything twice
          and to keep the text easier to read it will refer only to invoices. You can apply it
          equally to credit notes. Only where the behavior of credit notes differs from invoices
          this will be explicitly mentioned.
        

New



To send an invoice to a customer you must first create the new document. To create an invoice use
          Business → Customer → New
            Invoice
          . The New Invoice window must be filled in appropriately.
        
Figure 13.8. Creating a New Invoice
[image: Creating a New Invoice]



When you click the OK button, the Edit Invoice window
          opens.
        

Edit



From the Edit Invoice window you can enter an itemized list of goods and services you sold on this
          invoice in a manner similar to how the account register works. For credit notes you enter
          an itemized list of goods and services you refunded instead.
        
Figure 13.9. Edit Invoice Window
[image: Edit Invoice Window]



When you have finished entering all the items, you can Post and print the
          invoice.
        

Post



When you finish editing an invoice and are ready to print, you must Post the
          invoice. The invoice does not have to be posted immediately. In fact, you should only post
          an invoice when you are ready to print it. Posting an invoice places the transactions in
          an accounts receivable account.
        
Figure 13.10. Post Invoice Window
[image: Post Invoice Window]




Find



To find an existing invoice, use the
          Business → Customer → Find
            Invoice
          menu item. From the results of the search, you can select an invoice to edit or view.
        
Note
Before you can edit a posted invoice, you will need to Unpost it.
          

One of the design goals in GnuCash’s Account Receivable system was to allow different processes
          to get to the same state, so you can reach an invoice from different directions based on
          the way you think about the problem:
        
	You can search for the customer first, then list their invoices.
            

	You can search for invoices by number or by company name.
            

	You can list invoices associated with a customer job.
            




Print



After you post an invoice, you should print it and send it to your customer. To print an invoice use
          File → Print Invoice
          menu item.
        
Figure 13.11. Invoice Print Output
[image: Invoice Print Output]



Note
You can modify the appearance of the invoice, IE: add a company logo, etc. To do so, see the
            the section called “Changing the Invoice Appearance”.
          

Invoices can also be printed from the main window by selecting
          Reports → Business Reports → Printable Invoice
          from the main menu. The resulting report window states that no valid invoice is selected.
          To select the invoice to print:
        
	Use the Options Toolbar button or select
              Edit → Report Options
              from the main menu.
            

	Select the General tab of the report options dialog.
            

	Click the Select button next to the Invoice Number
              field.
            

	Search for the invoice as usual.
            



You can also print invoices from within the Process Payment dialog. See the
          the section called “Process Payment” for instructions on how to do so.
        

Assign Starting Invoice Number



By default, GnuCash starts with invoice number 1 and increments from there. You can manually type an
          invoice number into the text box each time you create an invoice, but this gets tiring and
          sooner or later leads to duplicate numbers.
        
You can change the starting invoice number if it is important you. Use
          File → Properties
          , access the Counters tab, change the Invoice
          number value to be one less than your desired starting invoice number and click
          the OK button or the Apply button.
        


Customer Jobs



Customer Jobs are used to group multiple invoices and credit notes to the same customer. Use of the
        Customer Jobs feature is optional. The feature is useful when you have multiple
        jobs for the same customer, and would like to view all the invoices and
        credit notes related to a single job.
      
Figure 13.12. New Customer Job
[image: New Customer Job]



To use customer jobs, you must create them using the
        Business → Customer → New
          Job
        menu item. You will see the New Job window.
      
To edit an existing customer job, use the
        Business → Customer → Find
          Job
        menu item. Select the desired job in the search results, and click the View/Edit
        Job button.
      
To select from the invoices and credit notes associated with a given job, use
        Business → Customer → Find
          Job
        menu item. Select the desired job in the search results and click the View
        Invoices button. A window listing invoices and credit notes associated with this
        job appears. Select an invoice or credit note and click the View
        Invoice button to open an invoice editor in the main application window.
      

Process Payment



Eventually, you will receive payment from your customers for outstanding invoices. To register these
        payments, use the Process Payment application found in
        Business → Customer → Process
          Payment
        .
      
Figure 13.13. Process Payment From Customer
[image: Process Payment From Customer]




Changing the Invoice Appearance



The default Invoice style, as shown in the section called “Print”, is
        fairly barren. The default invoice style leaves the top part of the form blank, so you can
        print on company letterhead paper. There are some things you can do to change invoice
        appearance.
      
Use
        File → Properties
        to enter your Company information in the Business tab of the
        Book Options window. Some of the entered information is printed on the
        right side of invoices.
      
To add a customized background, heading banner or logo to invoices, modify the invoice style sheets.
        To do this, go to
        Edit → Style Sheets
        and select the New button in the Select HTML Style
        Sheet window that will appear. You will then see a window like this:
      
Figure 13.14. New Style Sheet Window
[image: New Style Sheet Window]



Give a Name to the new style sheet (e.g. Custom Invoice)
        and select the Fancy Template. When you click the
        OK button, the HTML Style Sheet Properties
        window is displayed. This window presents you five sections listed in the left pane:
        Colors, Fonts, General,
        Images, and Tables. The
        Colors section allows you to change the colors of various items of the
        invoice. The Fonts section lets you set fonts type and dimensions. The
        General section allows you to set the Preparer and
        Prepared for information, and to Enable Links. The
        Images section allows you to import graphics into the style sheet. The
        Tables section allows you to adjust the spacing around the tables which
        make up the invoice.
      
To include a company logo, banner heading and background image, use your favorite graphics
        application such as The Gimp or Apache OpenOffice/LibreOffice 
        Draw to save the images in either GIF or
        PNG format. Then import them into the style sheet using the
        Images section described above.
      
Below is an example that imports all three types of images.
      
Figure 13.15. HTML Style Sheet Example Window
[image: HTML Style Sheet Example Window]The HTML Style Sheets window with an example Background Tile, Heading Banner, and
                Logo.
              





Note
The images are placed in the invoice as follows. The Background Tile is tiled
          to become the background image, the Heading Banner goes to above the
          invoice text, and the Logo is placed in the upper left corner of the
          invoice to the left of the Heading Banner. You will probably have to try a few different
          sized images until you get the invoices to print nicely. Some sizing suggestions are that
          the Logo should be 1 square cm (~0.5 inch), and the Heading Banner should be 15 cm (~6
          inches) wide and 1 cm (~0.5 inch) tall.
        

With the style sheet configured, when you print the invoice, you select the style sheet to use from
        the Options menu. Below is the resultant invoice after applying the style
        sheet demonstrated above.
      
Figure 13.16. HTML Style Sheets Example Output
[image: HTML Style Sheets Example Output]The hideous invoice which results from the graphics selected in the style sheet.
              







Chapter 14. Budgets



This chapter explains how to create and use budgets with GnuCash.
  
Basic Concepts



A budget is a tool for estimating expected income and expenses. You can use it to help you plan how
      you intend for your finances to change over a period of time, and to examine how your actual
      financial transactions for the period compare to your planned transactions.
    
The budgeting concept is quite general, so GnuCash offers a budgeting tool that is both simple and
      flexible. You, the user, have to decide how complex or simple you want to make your budget.
      This guide will help you make some of those decisions.
    
Terminology



There are a few helpful terms listed below that will be used to discuss budgeting.
      
	Budget - A financial plan describing the expected revenues and/or disbursements
            for a particular time period
          

	Cash Budget - A budget planning for expected cash receipts and cash
            disbursements. This type of budget tracks cash flow -- where your money comes from,
            where it goes, and, of course, how much.
          

	Expense Budget - A budget chiefly for planning what you spend your money on.
            This type of budget tracks your expenses. It is typically not concerned with things like
            appreciation or repayment of liabilities. However, it would account for interest
            charges. For example, if you buy $100 worth of groceries with your credit card, you
            incur an $100 expense for groceries, and a $100 liability to your credit card company.
            When you pay the credit card bill for $110, you are incurring an additional interest
            expense of $10. An expense budget plans for the transaction of buying the groceries and
            paying the interest, but not the transaction of repaying the credit card company.
          

	Capital Budget - A budget that describes a plan for paying for a large future
            expense, often through a combination of saving and borrowing money. Note: Capital
            budgets can sometimes get quite complex because they can try to answer the question "Can
            we afford to do such-and-such?" by exploring various hypothetical scenarios that can
            involve hypothetical accounts.
          

	Budget Period - The period of time during which the plan is expected to take
            place. The most common budget periods are annual and monthly. Sometimes, you may budget
            for several consecutive periods at once, for convenience or for finer-grained planning.
            For example, an annual budget may include 12 monthly budget periods.
          






Creating a Budget



Even before you begin to make a budget, it’s important to have given some thought to your
      account hierarchy. For example, if you want to budget a certain amount for your electric bill
      and a certain amount for your water bill, you can’t have only an
      Expenses:Utilities account. Your accounts must be at least as specific as
      your budget.
    
Choose Which Accounts To Budget For



The first step in creating a budget is to decide what it is you want to plan for. This decision will
        affect which accounts you include in your budget. For example, if you are only interested in
        tracking your expenses, you may create an expense budget by only entering amounts for
        expense accounts. On the other hand, if you want to track all of your cash flow, you may
        create a cash flow budget by entering amounts for asset, liability, income and expense
        accounts.
      
Before you begin to create your budget, you need to make two decisions: What accounts do I want to
        budget for? and When do I want my budget to be for? You can always change your mind later,
        after you’ve created a budget, but you need to start with something.
      
Tip
As a rule of thumb, if you mostly care about what you spend your money on, you
          may want to make an expense report. If you’re also concerned about having enough
          money in the right places at the right times, you may want to use a cash-flow budget.
        


Choosing a Budget Period



Before creating a budget you must also decide what period of time you want to plan for. The most
        common budget periods are monthly and annual. If you want your budget to plan for changes in
        financial patterns over time, then you should include multiple budget periods in your
        budget. For example, if you want to plan on having higher utility expenses in the winter
        than in the summer, then you might break your annual budget into 4 quarters or even 12
        months, and budget a higher value for the winter periods than for the summer periods.
      

Getting Started



To create your first budget click on
        Actions → Budget → New
          Budget
        . You will immediately see a new budget with the default settings and no entries. Then click
        on the Options button. The most important options are the budget
        period and the number of periods. For the budget period, choose the beginning date and the
        smallest period of time that you want to plan for. Then, for the number of periods, choose
        how many periods you want to plan for.
      
The budget page now shows a list of accounts with a column for each budget period. The date shown in
        the title of each column is the beginning of that budget period.
      

Entering Budget Values



Now, you must enter the budget values - the amounts that you expect the account balances to change
        during the budget period. There are two ways to enter budget values. The first way is to
        simply click on the cell and enter an amount.
      
If you have past transactions recorded in GnuCash, the second way is to let GnuCash estimate the budget
        values by looking at those transactions. First, select the accounts you want GnuCash to
        estimate. Then click on the Estimate Toolbar
        button. In the Estimate Budget Values dialog, select the date past
        which GnuCash should look for past transactions. GnuCash will start at that date and look
        forward for the duration of your budget. For example, if you are making an annual budget,
        and you select Jan. 1, 2005, GnuCash will look at all the transactions in that account from
        Jan. 1, 2005 through Dec. 31, 2005.
      


Chapter 16. Depreciation



This chapter will introduce the concept of depreciation in accounting and give some real life
    examples for using it.
  
Basic Concepts



Depreciation is the accounting method for expensing capital purchases over time. There are two
      reasons that you may want to record depreciation; you are doing bookkeeping for your own
      personal finances and would like to keep track of your net worth, or you are doing bookkeeping
      for a small busines and need to produce a financial statement from which you will prepare your
      tax return.
    
The method of recording depreciation is the same in either case. but the end goal is different. This
      section will discuss the differences between the two. But first, some terminology.
    
	Accumulated depreciation - the accumulated total of book depreciation taken
          over the life of the asset. This is accumulated in the depreciation account in the asset
          section.
        

	Book depreciation - this is the amount of depreciation that you record in your
          financial statements per accounting period.
        

	Fair market value - the amount for which an asset could be sold at a given
          time.
        

	Net book value - this is the difference between the original cost and the
          depreciation taken to date.
        

	Original cost - this is the amount that the asset cost you to purchase. It
          includes any cost to get the asset into a condition in which you can use it. For example -
          shipping, installation costs, special training.
        

	Salvage value - this is the value that you estimate the asset can be sold for
          at the end of it’s useful life (to you).
        

	Tax depreciation - this is the amount of depreciation that you take for income
          tax purposes.
        



Personal Finances



Depreciation is used in personal finances to periodically lower an asset’s value to give you
        an accurate estimation of your current net worth. For example, if you owned a car you could
        keep track of its current value by recording depreciation every year. To accomplish this,
        you record the original purchase as an asset, and then record a depreciation expense each
        year (See the section called “Example” for an example). This would result in the net book
        value being approximately equal to the fair market value of the asset at the end of the
        year.
      
Depreciation for personal finance has no tax implications, it is simply used to help you estimate
        your net worth. Because of this, there are no rules for how you estimate depreciation, use
        your best judgement.
      
For which assets should you estimate depreciation? Since the idea of depreciation for personal
        finances is to give you an estimate of your personal net worth, you need only track
        depreciation on assets of notable worth that you could potentially sell, such as a car or
        boat.
      

Business



As opposed to personal finance where the goal is tracking personal worth, business is concerned with
        matching the expense of purchasing capital assets with the revenue generated by them. This
        is done through book depreciation. Businesses must also be concerned with local tax laws
        covering depreciation of assets. This is known as tax depreciation. The business is free to
        choose whatever scheme it wants to record book depreciation, but the scheme used for tax
        depreciation is fixed. More often than not this results in differences between book and tax
        depreciation, but steps can be taken to reduce these differences.
      
Now, what purchases should be capitalized? If you expect something that you purchase to help you
        earn income for more than just the current year, then it should be capitalized. This
        includes things like land, buildings, equipment, automobiles, and computers - as long as
        they are used for business purposes. It does not include items that would be considered
        inventory. So if you made a purchase with the intent to resell the item, it should not be
        capitalized.
      
In addition to the purchase of the asset itself, any costs associated with getting the asset into a
        condition so that you can use it should be capitalized. For example, if you buy a piece of
        equipment and it needs to be shipped from out of town, and then some electrical work needs
        to be done so you can plug the machine in, and some specialized training is needed so you
        know how to use the machine, all these costs would be included in the cost of the equipment.
      
You also need to know the estimated salvage value of the asset. Generally, this is assumed to be
        zero. The idea behind knowing the salvage value is that the asset will be depreciated until
        the net book value (cost less depreciation) equals the salvage value. Then, when the asset
        is written off, you will not have a gain or loss resulting from the disposal of the asset.
      
The last step is to determine the method of depreciation that you want to use. This will be
        discussed on the next few pages.
      
Warning
Be aware that different countries can have substantially different tax policies for depreciation;
          all that this document can really provide is some of the underlying ideas to help you
          apply your “favorite” tax/depreciation policies.
        




Example



Let’s go ahead and step through an example. Imagine you are a photographer and you use a car
      and an expensive camera for your personal business. You will want to track the depreciation on
      these items, because you can probably deduct the depreciation from your business taxes.
    
The first step is to build the account hierarchy (as shown in the previous section, replace
      ITEM1 and ITEM2 with “car” and
      “camera”). Now, record the purchase of your assets by transferring the money from
      your bank account to the appropriate Asset Cost accounts for each item
      (eg: the Assets:Fixed Assets:Car:Cost account for the car). In this
      example, you start with $30k in the bank, the car cost $20k and the camera cost $10k and were
      both purchased on January 1, 2000.
    
Figure 16.1. Asset Accounts Before Depreciation
[image: Asset Accounts Before Depreciation]The asset accounts still only have the investments stored.
            





Looking at the tax codes, we realize that we must report depreciation on these items using the
      “sum of digits” scheme, over a 5 year period. So, the yearly depreciation amounts
      for the car come to $6667, $5333, $4000, $2667, $1333 for years 1 to 5 respectively, rounded
      to the nearest dollar. The yearly depreciation amounts for the camera are $3333, $2667, $2000,
      $1333, $667. Consult the previous section on Depreciation Schemes for the formula for
      calculating these values.
    
For each accounting period (IE: fiscal year) you record the depreciation as an expense in the
      appropriate Accrued Depreciation account (eg: the Assets:Fixed
      Assets:Car:Depreciation account for the car). The two windows below show your
      car’s accrued depreciation account and the main window after the third year (IE: three
      periods) of depreciation using this sum of digits scheme.
    
Figure 16.2. Asset Depreciation In The Register
[image: Asset Depreciation In The Register]This account shows a list of depreciation transactions.
            





Figure 16.3. Accounts Tab After Asset Depreciation
[image: Accounts Tab After Asset Depreciation]The asset accounts got decreased by the depreciation.
            





Note
A Word of Caution: Since depreciation and tax issues are closely related, you may not always be free
        in choosing your preferred method. Fixing wrong calculations will cost a whole lot more time
        and trouble than getting the calculations right the first time, so if you plan to depreciate
        assets, it is wise to make sure of the schemes you will be permitted or required to use.
      


Chapter 18. Importing Business Data



Importing Bills and Invoices



General



This functionality creates invoices or bills from a csv import file containing rows of invoice entry
        data. The import file may contain rows for new and/or existing invoices. If an invoice
        already exists, GnuCash adds the imported entries to the invoice (unless the invoice is
        already posted). If the import file contains posting data for an invoice, then GnuCash will
        also attempt to post the invoice. If any row of an invoice contains an error, GnuCash will
        ignore all rows of the same invoice.
      
The field separator in the csv file must be either a comma or a semicolon; field values may be
        enclosed in double quotes.
      
For the sake of readability, in this chapter the term “invoice” by itself is used to
        refer to both customer invoices and vendor bills.
      

The format of the import file



The import file should contain rows of invoice entry data. Any row contains both header and entry
        fields, but GnuCash takes the invoice header data from the first row of an invoice ID. For
        informational purposes, the header data may be repeated for each subsequent row of the same
        invoice.
      
There is no information in the file to indicate whether it concerns customer invoice or vendor bill
        data. Instead, a user option in the import dialog makes that distinction.
      
Each row should contain the fields listed below, in the same sequence, separated by a comma or a
        semicolon. The fields are listed here by their technical name, which GnuCash uses in the
        preview of the import data.
      
	id - The invoice ID. If the invoice ID is blank, GnuCash
            replaces it with the invoice ID from the previous row. If the invoice ID already exists,
            GnuCash will add the entries to the existing invoice (unless it is already posted).
          

	date_opened - Use the same date format as defined in
            Preferences. Defaulted to today's date if left blank, or if the date provided is not
            valid.
          

	owner_id - Customer or vendor number. Mandatory in the first
            data row of an invoice. If not provided, all rows of the same invoice will be ignored.
          

	billingid - Billing ID. Optional
          

	notes - Invoice notes. Optional.
          

	date - The date of the entry. Defaulted to date opened if left
            blank, or if the date provided is not valid.
          

	desc - Description. Optional
          

	action - Action. Optional
          

	account - Account for the entry. Mandatory in each row. If not
            provided or invalid, all rows of the same invoice will be ignored.
          

	quantity - Quantity. Defaulted to 1 if left blank.
          

	price - Price. Mandatory for each row. If not provided, all
            rows of the same invoice will be ignored.
          

	disc_type - Type of discount. Optional. Only relevant for
            invoices, not for bills. Use “%” or blank for percentage value, anything
            else for monetary value.
          

	disc_how - Discount how. Optional. Only relevant for invoices,
            not for bills. Use “>” for discount applied after tax, “=”
            for discount and tax applied before tax, and “<”, blank or anything else
            for discount applied before tax.
          

	discount - Amount or percentage of discount. Optional. Only
            relevant for invoices, not for bills
          

	taxable - Is this entry taxable? Optional. Use
            “Y” or “X” for yes, “N” or blank for no.
          

	taxincluded - Is tax included in the item price? Optional. Use
            “Y” or “X” for yes, “N” or blank for no.
          

	tax_table - Tax table. Optional. If the tax table provided
            does not exist, it will be blank in the invoice.
          

	date_posted - Date posted. Optional. Use the same date format
            as defined in Preferences. If you provide a date posted for the first row of an invoice,
            GnuCash will attempt to also post the invoice (as opposed to only saving or updating it).
          

	due_date - Due date. Optional. Use the same date format as
            defined in Preferences. Defaulted to date posted, if left blank. Only relevant in the
            first row of an invoice, if the invoice is posted.
          

	account_posted - Post to account, for vendor or customer
            posting. Only mandatory in the first row of an invoice, if the invoice is posted.
          

	memo_posted  - Memo. Optional. Only relevant in the first row
            of an invoice, if the invoice is posted.
          

	accu_splits - Accumulate splits? Optional. Use
            “Y” or “X” for yes, “N” or blank for no. Only
            relevant in the first row of an invoice, if the invoice is posted. If you use a
            spreadsheet program to create the import file, it is advised not to use blank for no,
            because a final column with only blanks may not be recognized as relevant data when the
            spreadsheet program creates the csv file.
          



Note on double quotes
If you use the field separator character within a field, the field value should be enclosed in
          double quotes. Only for the fields description (desc) and notes, can you also include a
          double quote within a quoted field value, by doubling the double quote. E.g.
          "This field value uses the separator, and a ""quoted"" word", would be
          imported as This field value uses the separator, and a "quoted" word.
        

Example content for two bills; one of 2 entries, and one of 3 entries. The first is saved and
        posted, the second only saved. Using comma field separator, decimal point and dd/mm/yyyy
        date format.
      

1204;15/12/2018;2001;PO 210220;Special delivery;16/12/2018;Pride and Prejudice;pc;Expenses:Books;1;30.00;;;;X;;A1;17/12/2018;17/1/2019;Liabilities:Accounts Payable;;X
1204;15/12/2018;2001;PO 210220;Special delivery;16/12/2018;Electronic principles;pc;Expenses:Books;1;50.00;;;;X;;A1;17/12/2018;17/1/2019;Liabilities:Accounts Payable;;X
1205;15/12/2018;2044;PO 21099;;16/12/2018;Ultimate Guide;pc;Expenses:Books;1;10.01;;;;;;;;;;;
1205;15/12/2018;2044;PO 21099;;16/12/2018;Dinner & drinks;pc;Expenses:Dining;1;10.01;;;;;;;;;;;
1205;15/12/2018;2044;PO 21099;;16/12/2018;UG course;pc;Expenses:Education;1;10.01;;;;;;;;;;;
				

      
Example content for one customer invoice, with one entry, including tax and discount. Using comma
        field separator, decimal point and dd/mm/yyyy date format. The the value of the description
        field contains the separator character.
      

20221;16/12/2018;1001;Order 3378;Discount as agreed;4/12/2018;"Accounting part 1, 2";ea;Income:Other Income;1;769.95;%;=;10;X;N;A1;16/12/2018;16/01/2019;Assets:Accounts Receivable;Posted by import;X
				

      

Import your data



To import your invoice data, navigate to
        File → Import → Import Bills &
          Invoices…
        to open a new import dialog, and provide the necessary information.
      
	1. Choose the file to import - Select your import file, or manually type the
            path and file name.
          

	2. Select import type - Select the import type, either
            Bill or Invoice.
          

	3. Select import options - Select your csv format. Use the with
            quotes options if your file contains fields enclosed in double quotes. These
            options also match fields not enclosed in quotes; except for the fields for description
            and notes, fields should not contain the quote character itself. See
            Note on double quotes above. Use one of the other options
            if your file does not have fields enclosed in quotes; any quote characters in the file
            will be imported as is.
          

	4. Preview - Once you have selected your import file and csv format, GnuCash
            shows you a preview of the data. You can verify if your data is listed in the correct
            columns. If you do not see any rows in the preview, then GnuCash was not able to match
            your import data rows to the selected csv format. See
            the section called “What could go wrong?” below.
          

	5. Afterwards - You can choose if GnuCash should open tabs for the invoices after
            the import. Either for all invoices, or for the invoices that are saved but not posted,
            or for none of the invoices. Opening tabs slows down the import process considerably.
          

	Start the import - If you are satisfied with your selections, hit the
            OK button to start the import.
          



If your data file contains invoice IDs that already exist, then GnuCash will ask you (once per import
        session) to confirm that you want to update existing invoices. If not confirmed, all rows
        for existing invoices will be ignored.
      
Note
Internally, GnuCash uses so called regular expressions to match the import rows to the data fields.
          The import option Custom regular expression offers the option to use
          your own regular expression for this matching process. Obviously, this option requires
          that you are well versed in regular expressions. When you choose the option
          Custom regular expression, GnuCash opens a window in which you can edit
          the GnuCash regular expression, or replace it with your own. Your regular expression should
          contain a named subpattern for each of the fields of the csv file (using the technical
          names). A custom regular expression could be useful if the rows of your source data file
          contain all required fields, but in a different order or format. E.g. if the format of
          your source data file starts with customer number, followed by invoice ID, followed by the
          due date, and uses | as separator, your regular expression would start with something like
          this:
        

	^(?<owner_id>[^|]*)\|(?<id>[^|]*)\|(?<due_date>[^|]*)
						

        
With a custom regular expression, GnuCash could import your source data files, without the need to
          convert them to the GnuCash import format.
        


Feedback and statistics



GnuCash executes the import process in three steps:
      
	Import - Imports the data file and attempts to match each row
            to the data fields.
          

	Validation and adjustment - Validates the data fields and
            replaces data with defaults if applicable.
          

	Processing - Handles the currency related validations, and
            creates, updates and posts the invoices.
          



After all steps have finished, GnuCash issues information about the result of the process. The initial
        dialog shows the informational or error messages from the validation and processing steps.
        The second dialog shows the statistics of the process:
      
	Import - rows ignored: the number of rows that could not be matched to the data fields.
          

	Import - rows imported: the number of rows that were successfully matched to the data fields.
          

	Processing and validation - rows fixed: the number of rows for which a default value was used for a
            field.
          

	Processing and validation - rows ignored: the number of rows for that were not processed because of
            a validation error.
          

	Processing and validation - invoices created: the number of invoices created.
          

	Processing and validation - invoices updated: the number of invoices that were updated.
          



If there were unmatched rows in the import step, a final dialog shows the actual rows that could not
        be matched.
      

What could go wrong?



Errors in the import step



If the statistics show unmatched rows under “Import - rows ignored”, then there is some
          issue with the format of your import file. Verify that you use and select the correct
          separator. Verify that your data rows have exactly 21 separator characters (1 for each
          field, except for the last). Verify whether you use the separator character within a data
          field; if so, enclose the field in double quotes.
        
If you use one of the with quotes import options, verify if you use the double
          quote character in any of the data field values; if within the description or notes
          fields, make sure that the field value is quoted, and precede each double quote within the
          field with an extra double quote; if within any other field, remove the double quote
          character.
        

Errors in the validation step



The following errors can occur in the validation step. Any error in a data row will cause all rows
          of the same invoice to be ignored.
        
Note
In versions 3.4 and earlier, an error in a data row would cause just that row to be ignored, as
            opposed all rows of the same invoice.
          

	The field ID is blank. GnuCash replaces a blank invoice ID with the invoice ID from
              the previous row. But the first row of the import file should always have an invoice
              ID.
            

	The field owner_id is blank. Every first row of an invoice should have an owner_id.
            

	The customer or vendor number in field owner_id does not exist. The owner_id in the
              first row of an invoice should be an existing customer (for invoices) or vendor (for
              bills).
            

	The date in field date_posted is not a valid date. If you provide a value for
              date_posted in the first row of an invoice, it should be a valid date. Did you use the
              date format as set in Preferences?
            

	The account in the field account_posted does not exist. If you provide a value for
              the field date_posted in the first row of an invoice, the field
              account_posted should be an existing account.
            

	The account in the field account_posted is not of type Accounts Receivable (for
              invoices) or Accounts Payable (for bills). If you provide a value for the field
              date_posted in the first row of an invoice, the field
              account_posted should be an account of the correct type.
            

	The field price is blank. Every row should have a value for the field
              price.
            

	The account in the field account does not exist. Every row should have an existing
              account in the field account.
            



Any error in the validation step is listed after the overall import process completes. Correct your
          data file accordingly.
        

Errors in the processing step



The following errors can occur in the processing step.
        
	The invoice cannot be updated because it is already posted. All rows of the same invoice will be
              ignored. If you want to update the existing invoice, unpost it first in GnuCash.
            

	The currency of the invoice differs from the currency of the account posted (“Invoice x NOT
              posted because currencies don't match”). GnuCash determines the currency of the
              invoice either from the customer or vendor master data (for a new invoice) or from the
              invoice itself (for an existing invoice). The currency of the invoice must agree with
              the currency of the post to account in the field account_posted.
              GnuCash creates the invoice but cannot post it. Manually correct the invoice in GnuCash.
            

	The invoice requires currency conversion. (“Invoice x NOT posted because it requires currency
              conversion”). The invoice contains entries on accounts with different
              currencies, or the currency of the entries differs from the currency of the post to
              account. For such an invoice, GnuCash needs exchange rates to translate the currency
              amounts. GnuCash creates the invoice but cannot post it. Post the invoice manually in
              GnuCash, and provide the requested exchange rates.
            





Not supported invoice functionality



Currently the invoice import function does not support (at least) the following:
      
	Import of billing terms and job.
          

	Import of customer and job in default chargeback project for bills.
          

	Application of billing terms from customer or vendor master data.
          

	Automatic numbering of invoices.
          

	Credit notes.
          






Part IV. Appendices




1. APPLICABILITY AND DEFINITIONS



This License applies to any manual or other work that contains a notice placed by the copyright
      holder saying it can be distributed under the terms of this License. The
      “Document”, below, refers to any such manual or work. Any member of the public is
      a licensee, and is addressed as “you”.
    
A “Modified Version” of the Document means any work containing the Document or a
      portion of it, either copied verbatim, or with modifications and/or translated into another
      language.
    
A “Secondary Section” is a named appendix or a front-matter section of the
      Document that deals exclusively with the
      relationship of the publishers or authors of the Document to the Document’s overall
      subject (or to related matters) and contains nothing that could fall directly within that
      overall subject. (For example, if the Document is in part a textbook of mathematics, a
      Secondary Section may not explain any mathematics.) The relationship could be a matter of
      historical connection with the subject or with related matters, or of legal, commercial,
      philosophical, ethical or political position regarding them.
    
The “Invariant Sections” are certain  Secondary
      Sections whose titles are designated, as being those of Invariant Sections, in the
      notice that says that the Document is released under
      this License.
    
The “Cover Texts” are certain short passages of text that are listed, as Front-Cover
      Texts or Back-Cover Texts, in the notice that says that the
      Document is released under this License.
    
A “Transparent” copy of the  Document means a
      machine-readable copy, represented in a format whose specification is available to the general
      public, whose contents can be viewed and edited directly and straightforwardly with generic
      text editors or (for images composed of pixels) generic paint programs or (for drawings) some
      widely available drawing editor, and that is suitable for input to text formatters or for
      automatic translation to a variety of formats suitable for input to text formatters. A copy
      made in an otherwise Transparent file format whose markup has been designed to thwart or
      discourage subsequent modification by readers is not Transparent. A copy that is not
      “Transparent” is called “Opaque”.
    
Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo
      input format, LaTeX input format, SGML or XML using a
      publicly available DTD, and standard-conforming simple
      HTML designed for human modification. Opaque formats include PostScript,
      PDF, proprietary formats that can be read and edited only by proprietary word processors,
      SGML or XML for which the DTD and/or
      processing tools are not generally available, and the machine-generated
      HTML produced by some word processors for output purposes only.
    
The “Title Page” means, for a printed book, the title page itself, plus such following
      pages as are needed to hold, legibly, the material this License requires to appear in the
      title page. For works in formats which do not have any title page as such, “Title
      Page” means the text near the most prominent appearance of the work’s title,
      preceding the beginning of the body of the text.
    

3. COPYING IN QUANTITY



If you publish printed copies of the Document numbering
      more than 100, and the Document’s license notice requires
      Cover Texts, you must enclose the copies in
      covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front
      cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly
      identify you as the publisher of these copies. The front cover must present the full title
      with all words of the title equally prominent and visible. You may add other material on the
      covers in addition. Copying with changes limited to the covers, as long as they preserve the
      title of the Document and satisfy these conditions, can be
      treated as verbatim copying in other respects.
    
If the required texts for either cover are too voluminous to fit legibly, you should put the first
      ones listed (as many as fit reasonably) on the actual cover, and continue the rest onto
      adjacent pages.
    
If you publish or distribute Opaque copies of the
      Document numbering more than 100, you must either
      include a machine-readable Transparent copy along
      with each Opaque copy, or state in or with each Opaque copy a publicly-accessible
      computer-network location containing a complete Transparent copy of the Document, free of
      added material, which the general network-using public has access to download anonymously at
      no charge using public-standard network protocols. If you use the latter option, you must take
      reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure
      that this Transparent copy will remain thus accessible at the stated location until at least
      one year after the last time you distribute an Opaque copy (directly or through your agents or
      retailers) of that edition to the public.
    
It is requested, but not required, that you contact the authors of the
      Document well before redistributing any large number of
      copies, to give them a chance to provide you with an updated version of the Document.
    

4. MODIFICATIONS



You may copy and distribute a Modified Version of the
      Document under the conditions of sections
      2 and 3 above,
      provided that you release the Modified Version under precisely this License, with the Modified
      Version filling the role of the Document, thus licensing distribution and modification of the
      Modified Version to whoever possesses a copy of it. In addition, you must do these things in
      the Modified Version:
    
	A. Use in the Title Page (and on the covers, if any) a title
            distinct from that of the Document, and from
            those of previous versions (which should, if there were any, be listed in the History
            section of the Document). You may use the same title as a previous version if the
            original publisher of that version gives permission.
          

	B. List on the Title Page, as authors, one or more persons or
            entities responsible for authorship of the modifications in the
            Modified Version, together with at least five of the
            principal authors of the Document (all of its
            principal authors, if it has less than five).
          

	C. State on the Title Page the name of the publisher of the
            Modified Version, as the publisher.
          

	D. Preserve all the copyright notices of the Document.
          

	E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.
          

	F. Include, immediately after the copyright notices, a license notice giving the public permission to
            use the Modified Version under the terms of this
            License, in the form shown in the Addendum below.
          

	G. Preserve in that license notice the full lists of  Invariant
            Sections and required Cover Texts given in
            the Document’s license notice.
          

	H. Include an unaltered copy of this License.
          

	I. Preserve the section entitled “History”, and its title, and add to it an item stating
            at least the title, year, new authors, and publisher of the
            Modified Version as given on the
            Title Page. If there is no section entitled
            “History” in the Document, create one
            stating the title, year, authors, and publisher of the Document as given on its Title
            Page, then add an item describing the Modified Version as stated in the previous
            sentence.
          

	J. Preserve the network location, if any, given in the
            Document for public access to a
            Transparent copy of the Document, and likewise
            the network locations given in the Document for previous versions it was based on. These
            may be placed in the “History” section. You may omit a network location for
            a work that was published at least four years before the Document itself, or if the
            original publisher of the version it refers to gives permission.
          

	K. In any section entitled “Acknowledgements” or “Dedications”, preserve the
            section’s title, and preserve in the section all the substance and tone of each of
            the contributor acknowledgements and/or dedications given therein.
          

	L. Preserve all the Invariant Sections of the
            Document, unaltered in their text and in their
            titles. Section numbers or the equivalent are not considered part of the section titles.
          

	M. Delete any section entitled “Endorsements”. Such a section may not be included in the
            Modified Version.
          

	N. Do not retitle any existing section as “Endorsements” or to conflict in title with any
            Invariant Section.
          



If the Modified Version includes new front-matter sections or
      appendices that qualify as Secondary Sections and contain
      no material copied from the Document, you may at your option designate some or all of these
      sections as invariant. To do this, add their titles to the list of
      Invariant Sections in the Modified Version’s
      license notice. These titles must be distinct from any other section titles.
    
You may add a section entitled “Endorsements”, provided it contains nothing but
      endorsements of your Modified Version by various
      parties--for example, statements of peer review or that the text has been approved by an
      organization as the authoritative definition of a standard.
    
You may add a passage of up to five words as a Front-Cover
      Text, and a passage of up to 25 words as a
      Back-Cover Text, to the end of the list of
      Cover Texts in the
      Modified Version. Only one passage of Front-Cover Text and
      one of Back-Cover Text may be added by (or through arrangements made by) any one entity. If
      the Document already includes a cover text for the same
      cover, previously added by you or by arrangement made by the same entity you are acting on
      behalf of, you may not add another; but you may replace the old one, on explicit permission
      from the previous publisher that added the old one.
    
The author(s) and publisher(s) of the Document do not by
      this License give permission to use their names for publicity for or to assert or imply
      endorsement of any Modified Version .
    

6. COLLECTIONS OF DOCUMENTS



You may make a collection consisting of the Document and
      other documents released under this License, and replace the individual copies of this License
      in the various documents with a single copy that is included in the collection, provided that
      you follow the rules of this License for verbatim copying of each of the documents in all
      other respects.
    
You may extract a single document from such a collection, and dispbibute it individually under this
      License, provided you insert a copy of this License into the extracted document, and follow
      this License in all other respects regarding verbatim copying of that document.
    

8. TRANSLATION



Translation is considered a kind of modification, so you may distribute translations of the
      Document under the terms of
      section 4. Replacing
       Invariant Sections with translations requires
      special permission from their copyright holders, but you may include translations of some or
      all Invariant Sections in addition to the original versions of these Invariant Sections. You
      may include a translation of this License provided that you also include the original English
      version of this License. In case of a disagreement between the translation and the original
      English version of this License, the original English version will prevail.
    

10. FUTURE REVISIONS OF THIS LICENSE



The Free Software Foundation may publish new,
      revised versions of the GNU Free Documentation License from time to time. Such new versions
      will be similar in spirit to the present version, but may differ in detail to address new
      problems or concerns. See
      http://www.gnu.org/copyleft/.
    
Each version of the License is given a distinguishing version number. If the
      Document specifies that a particular numbered version of
      this License “or any later version” applies to it, you have the option of
      following the terms and conditions either of that specified version or of any later version
      that has been published (not as a draft) by the Free Software Foundation. If the Document does
      not specify a version number of this License, you may choose any version ever published (not
      as a draft) by the Free Software Foundation.
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